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Introduction

Introduction

What is Grasshopper?

Grasshopper (GH) is a node-based algorithm editor integrated with Rhino modeling tools.
Algorithms are used to describe logical relationships among design parameters that define the
parametric model. Through algorithms, the user is able to establish a set of rules that define the
sequence of operations, thus aiding the design process.

What is the purpose of the Grasshopper-ARCHICAD Live Connection tool?

The Grasshopper-ARCHICAD Live Connection offers a unique, algorithm-based workflow, which
helps you explore a large number of design variations and create and fine-tune building details and
structures - without exchanging files.

Key features and benefits

e Translate simple geometry created in Rhino into BIM construction elements
e Bi-directional connection — no need to export/import file for data exchange
e Dynamic (live) connection while editing

e Direct and simultaneous graphical feedback from both Rhino and ARCHICAD

Supported workflows

This set of tools enables Rhino/Grasshopper (GH) and ARCHICAD (AC) to communicate directly.
Designers working in either Rhino/Grasshopper or ARCHICAD can utilize its functionality to their
advantage. Users can start the design process in either work environment (AC or RH or GH). In each
case, the user will select an original set of reference geometries to be manipulated via Grasshopper,
or create it from scratch in Grasshopper.

e “Start with pure 3D geometry” workflow: Designers start with the design geometry using
Rhino and Grasshopper. With the “GH-AC Connection” tool, they can dynamically generate a
BIM model consisting of ARCHICAD construction elements, and update the resulting BIM model
directly from Grasshopper.

e “Start with intelligent building elements” workflow: Designers start with the design in ARCHICAD
and extend their AC toolbox with algorithmic design methods applied to AC elements. In this
workflow, input reference geometries (reference points, curves and other parameters) are taken
directly from ARCHICAD and used in Grasshopper, without interaction in Rhino.

Scope of the manual

This manual is intended to explain only the added functionality of creating ARCHICAD elements
from Grasshopper. The general description of functionality of ARCHICAD, Grasshopper or Rhino is
not in the scope of this manual. To acquire the necessary basic knowledge in these applications,
please visit the following sites.

e Grasshopper Training Center: http://www.grasshopper3d.com/page/tutorials-1

e ARCHICAD Training Materials:_http://www.graphisoft.com/learning/training_materials/

e Rhinoceros3D Learning Center:_http://www.rhino3d.com/learn
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Getting Started

Getting Started

Install Add-Ons (Windows)

To achieve a connection between the ARCHICAD and Grasshopper applications, you must install a
GRAPHISOFT extension: the Grasshopper — ARCHICAD Live Connection.

Before installing it, make sure that the latest version of Rhinoceros for Windows (Version 5 64-bit)
and ARCHICAD 21 are both installed on your computer.

To launch the Setup Wizard of the Connection add-on, double-click on its .MSI file and go through
the steps as shown on the setup screens.

Note: ARCHICAD-Grasshopper Connection only works with the 64-bit version of Rhino 5.

#  Grasshopper-ARCHICAD Live Connection Setup - #  Grasshopper-ARCHICAD Live Connection Setup - #  Grasshopper-ARCHICAD Live Connection Setup - #  Grasshopper-ARCHICAD Live Connection Setup -
Desti

AN End-User License Agreement. ination Folder =
Welcome to the Grasshopper-ARCHICAD Plase read the follwing icense agreement carefilf] b orcick Chade o dhabse anofh =Ly 4
Live Connection Setup Wizard

5 Instal Grasshopper-ARCHICAD Live Connecton to
IMPORTANT ClckInstal to begin the nstalaton. Clck Back to review or change any of your
installation it the vizerd,

PPLEASE READ THIS AGREEMENT CAREFULLY, BY settings. Click Cancel to exit
CLICKING THE "I ACCEPT" BUTTON, YOU INDICATE [c-1rogram Fies\GRAPHISOFTVARCHICAD 21\

instal Grasshopper-ARCHICAD Live:
+. Clck Next to continue or

IYOUR ACCEPTANCE OF THE GRAPHISOFT LICENSE [ |
IAGREEMENT ("Agreement") INCLUDING THE LIMITED

IWARRANTY, PERSONAL DATA HANDLING AND

I DISCLAIMERS FOR YOURSELF, YOUR EMPLOYER (IF

IANY) AND ANY AUTHORIZED USERS WHETHER OR

accept the terms n the License Agreement

Install Add-Ons (Mac)

To achieve a connection between the ARCHICAD and Grasshopper applications, you must install a
GRAPHISOFT extension: the Grasshopper — ARCHICAD Live Connection.

Before installing it, make sure that the latest version of Rhinoceros for MAC (Version 5 64-bit) and
ARCHICAD 21 are both installed on your computer.

Important: Rhino for Mac is currently at a “Work in Progress” stage of development. It does not
yet contain all of the features available in Rhino for Windows. For details, see:
https://www.rhino3d.com/mac-feature-compare.

To launch the Setup Wizard of the Connection add-on, double-click on its. PKG file and go through
the steps as shown on the setup screens.

Note: ARCHICAD-Grasshopper Connection only works with the 64-bit version of Rhino 5.

“lee sl rashapper ARCHICAD Live Conneon O st

The installation was successful.

The software was nstalled

AGREEMENT
1. LICENSE

Launch the Applications

1. Launch ARCHICAD.
2. Launch Rhinoceros 3D (Rhino).

3. From Rhino, launch Grasshopper: Type the word “Grasshopper” into the Rhino Command Line
and hit ENTER.
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Notes:

o Once all three applications are running, it is recommended to arrange the windows so that
they do not overlap. (For ease of use, use multiple screens).

o To receive notifications and information from the add-ons, turn on the Status bar palette in
ARCHICAD (Window > Palettes > Status bar).

Start the Connection

e In ARCHICAD, go to File > Interoperability > Grasshopper Connection.
e A small floating palette appears with the “Start Connection” button on it. Click to start the
connection.
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Grasshopper Palette in ARCHICAD

To open the Grasshopper palette in ARCHICAD, go to File > Interoperability > Grasshopper
Connection.

Note: Like any other palette in ARCHICAD, the Grasshopper palette is also available from
Window > Palettes.

The palette contains 3 buttons: T
e Start/Break Connection: Click to turn on/turn off the connection between ORI (e
Grasshopper and ARCHICAD. B @

e Send Changes: Updates Grasshopper about changes made in ARCHICAD. This g
button is active only when you are editing an ARCHICAD element referred to by Select in GH
the Grasshopper code via a Parameter Node (see the Parameter Nodes section
below).

e Select in GH: In Grasshopper, selects the nodes which generated the elements currently
selected in ARCHICAD. This button is active only if the current ARCHICAD selection includes at
least one element generated by the Grasshopper code.

Notes:

o |f the green icon is spinning, this indicates that the connection with Grasshopper is live, and
ARCHICAD is now ready to send and receive information.

° The palette also tells you which currently opened Grasshopper document is connected to
ARCHICAD.
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ARCHICAD Tab in Grasshopper

In Grasshopper, a new “ARCHICAD” tab has appeared on Grasshopper's tab bar. The icons on this
tab resemble those of ARCHICAD tools; they represent Component Nodes, Parameter Nodes and
Input Nodes.

Grasshopper - unnamed - O *
Fle Edit View Display Solution Help unnamed
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BE[w» E-e-y Q@ R0 0

Command in Grasshopper’s File menu

In Grasshopper, a new command appears in the File menu: “Connect Document to ARCHICAD”. This
command opens a dialog box: among the currently open Grasshopper files, choose the one that
should communicate with ARCHICAD.

Grasshopper - Definition_2 - m] X
Fle | Edt View Display Soltion Hel Definition_2
7] Mew Document CirisN biace Mesh Intersect Transform Display | ARCHICAD
Open Document 0 . [ [ | o
EI eﬂ 5] & tf Connect Document to ARCHICAD - O X
Recent Files s o0 = A
0 6] Select the Grasshopper document which should communicate with ARCHICAD @
B save Document Ctl+S
[ =7 Status  Mame Path G
[5] Save Documentfs.  Cil+ShitsS @ @ @ D - it
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Rl Y e Definiion_1 C:\Users barothy\Desktop \ATMENETI\Defi o
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< >
E Ribbon Layout »
=
Show In Folder
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12
]
@ Autosave complete (280 seconds ago) 0.9.0076

Preview Option in Grasshopper’s Display Menu

Most components of Grasshopper-ARCHICAD Connection generate a detailed preview in Rhino,
using colors that match those of the ARCHICAD model. However, generated Library Parts (Object,
Window, Door) display only a bounding box as a preview, by default. (Otherwise, the high polygon
count might affect performance.)
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To see a detailed preview of Library Parts in Rhino (instead of just the bounding box), turn on the
Detailed ARCHICAD Preview toggle in Grasshopper’s Display menu.
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Uninstall Grasshopper Connection

Uninstall Grasshopper Connection

If you uninstall Grasshopper Connection (for ARCHICAD 21 or earlier), make sure you follow these
steps - otherwise, you may run into errors when reinstalling.

Windows
Remove the application using the “Apps & features” utility, accessible from Windows Settings.

Mac
1. Go to the ARCHICAD folder, and locate the Add-On\Local folder.

2. Delete the following items from the Local folder:

— GrasshopperConnection
— ProductVersion.xml

3. Go to the following folder: ~/Library/Application Support/McNeel/Rhinoceros/MacPlugins/
Grasshopper/Libraries/ARCHICAD xx (where xx is the ARCHICAD version number)

4. Delete the ARCHICAD xx folder (it contains a file named ArchiCADConnection.gha)
5. Go to the Terminal App window.
6. Copy-paste the following line, then press Enter:

sudo pkgutil --forget "com.graphisoft.ArchiCAD.Goodies.GHACLivelInstaller"
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ARCHICAD Nodes

The ARCHICAD tab page in Grasshopper contains Parameter nodes, Component nodes, and Input
nodes. Parameter nodes store geometric information; components perform the operations that
generate data; input nodes provide access to certain ARCHICAD value sets.

Parameter nodes refer to point coordinates or existing 2D or 3D geometry in
the ARCHICAD project. Most of the Parameter nodes represent special
ARCHICAD data that can be interpreted only by other ARCHICAD
Components. However, in the case of Point, 2D Curve, and Spline Parameter
nodes, the referenced geometry can be transformed by regular Grasshopper
components (such as Move) in the usual way, and can also be used as the initial input for GH code.

See details at ARCHICAD Parameter Nodes.

Design and Document components generate native 2D or 3D elements 0 =
in ARCHICAD - such as Polylines, Walls, Objects, and Windows. == EFE( Dﬁ < < B

At present, Grasshopper components can interpret output only from 0 EH f GOL (5
the Spline and 2D Curve components, because these are automatically EE% 25 CFﬁG' 8,
converted to the native Grasshopper Curve data type.

The rest of the ARCHICAD components generate a special type of data that cannot be
converted into built-in Grasshopper data types. For this reason, Grasshopper
operations (such as the Move component) cannot be carried out on the geometry
generated by the AC components. The AC components can be placed downstream from the GH
nodes, but the Grasshopper definition ends there.

i T

Synchronize
4 @ F Curve =3 Beam
\ Curve e Beam Settings
Count f Tangents Synchronize

W © 10 Kinks Parameters Anchor Point

U Celumn
End Point

Column Settings

Curve Points

Count f Tangents
Kinks Parameters Synchronize %

II (| Geometry o Geometry Curve % Beam
( Motion °ﬂ Transform Beam Settings

GH Definition AC Components

See more details at ARCHICAD Document Components and ARCHICAD Design Components.

Deconstruct components: These are used to break down 2D and 3D '% S5 D P 0 Lok
ARCHICAD elements into their constituent parts. mm e e
(e U S e VAt Hig

Deconstruct components are the inverse of the element-generating Design A e 1
Mg & Qe dd Ta g

and Document components. Use Deconstruct components to access the
geometry data of the input ARCHICAD elements. A Deconstruct component
can also reference an existing, manually placed ARCHICAD element.

See more details at ARCHICAD Deconstruct Components.
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ARCHICAD Nodes

Settings components are available for each Design and Document
component. The Settings component sets parameter values for the
element generated in ARCHICAD. Attach a Settings component to the
“Settings” input parameter of the data-generating component.

Extract Settings components: Used to break down ARCHICAD element
settings into parts.

Extract Settings components are the inverse of the Settings
components: they break down the Settings data referenced at input.
Use Extract Settings components to get these element settings for use in
another operation.

See more details at ARCHICAD Extract Settings Components.

Reshape components can modify elements produced by certain ARCHICAD components %
(Fill, Slab and Roof components). Currently there are two Reshape components: the
Subtract Polygon and the Add Polygon.

See more details at ARCHICAD Reshape Components.

Input nodes: An input node stores a list of values received from ARCHICAD.
The available values are continuously refreshed, so that they always
correspond to the set of values contained in ARCHICAD. At present, twelve
input nodes are available: 2D Viewpoint, Composite, Fill Pattern, Line Type,
Profile, Surface, Building Material, Favorite, Layer, Pen, Story Plane and
Zone Category.

Place ARCHICAD Nodes

The ARCHICAD (AC) nodes available on Grasshopper’s ARCHICAD tab work the same way as other
components or parameters in Grasshopper. Use the familiar methods to place them on the
Grasshopper canvas. After the required input parameters are received, a preview is immediately
visible in the Rhino window.
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ARCHICAD Parameter Nodes

AC Parameter nodes refer to point coordinates or existing 2D or 3D gooooo

geometry in the ARCHICAD project.
QOCLLO

0LDHO

Most of the Parameter nodes represent special ARCHICAD data that can be
interpreted only by other ARCHICAD components. However, data stored by
the AC Point, AC Spline and AC 2D Curve Parameter nodes can be converted
automatically by Grasshopper into native Point and Curve data. Therefore, these three Parameter
nodes are an integral part of the Grasshopper code.

AC Point Parameter Node

Like Grasshopper’s Point parameter, the ARCHICAD Point =
parameter (AC Point) can store 3D point data. This data is defined

in ARCHICAD, not in Rhino. The AC Point parameter can |P°“. | &
reference a single or multiple 3D points. E:‘::
Set One Point S o
L) Runtimewarnings b
1. In Grasshopper, right-click on the center of the AC Point. i Diply ’
2. Select ‘Set One Point in ARCHICAD’ from the context menu. Reverse
(The Rhino and GH windows close. In ARCHICAD, notice that FHEE
the Status Bar displays the message: “Click a point”.) :-m&w
impli

3. Click in the ARCHICAD window to define the origin of the AC —
Point. (If the point is selected successfully, the Rhino and GH S
windows appear again, and the parameter node turns from
yellow to gray, to indicate that it is not empty.)

Clear values

Internalise data

4. Now continue working as needed in ARCHICAD, or return to Extract parameter
Grasshopper. @ Hep..

Note: The value stored in the parameter node can be
redefined at any time using the “Set One Point” or “Set Multiple Points” commands.
Set Multiple Points

1. In Grasshopper, right-click on the center of the AC Point.
Select "Set Multiple Points in ARCHICAD from the context menu.

Click several times in the ARCHICAD window to define a collection of points.

R WN

Click ESC to exit input mode.

umn umn { Geometry o Geometry t

( Motion Transform

'm' ( Start Point / L
ine D
( End Point
@ Point

Cantains  collection of three-dimensional ARCHICAD pointcoordinates.

One locslly defined walue..
Point
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Note: The AC Point component converts the point defined in ARCHICAD into a Grasshopper
Point parameter. This AC Point parameter node can then be assigned to any GH component
that requires a GH Point-type input.

To define the origin of an AC Point, you can also click on any hotspot of a placed ARCHICAD element.
In this case, the AC Point will remain associated to its parent element in ARCHICAD.

For example:
1. In Grasshopper, place two AC Point parameter nodes.

2. To define their origins, go to ARCHICAD and click the endpoints of an already placed Beam
element.

3. In ARCHICAD, move the Beam to a new position.

4. Click the ‘Send Changes’ button on the Grasshopper Connection Palette: the coordinates stored
in the AC Point parameters are modified to match the Beam’s new position.

2D Curve and Spline Parameter Nodes

2D Curve Parameter node can reference one or more 2D elements drawn in ARCHICAD with the
Line, Polyline or Circle Tool, while the Spline Parameter node does the same for elements created
with the ARCHICAD Spline tool.

Note: You can use the 2D Curve or Spline Parameter node to reference any Polyline, Circle or
Spline element drawn in any 2D ARCHICAD Viewpoint (Floor Plan, Section, Elevation, etc.).
However, in Grasshopper, the new planar shape will always be drawn in the XY plane.

Referencing a polyline in ARCHICAD:
1. Draw a polyline in ARCHICAD with the Polyline Tool.
2. In Grasshopper, place an AC 2D Curve Parameter node and right-click on its center.

3. Select ‘Set One 2D Curve’ from the context menu. (The Rhino and GH windows close. In
ARCHICAD, notice that the Status Bar displays the message: “Click an element”.)

Note: If any ARCHICAD elements are selected at the time you issue the ‘Set One 2D Curve’
command, and if the set of selected elements includes one element drawn with the Polyline/
Line/Circle Tool, then the parameter is automatically defined according to the selected element,
and no further element selection is needed. If the selection does not include a Polyline/Line/
Circle element, or if there are multiple selected Polylines/Lines/Circles, then the program will
deselect the elements, and prompt you to select elements in ARCHICAD.

4. Click on the previously drawn polyline in the ARCHICAD window. The 2D Curve Parameter node
is now referencing the selected ARCHICAD element.

The 2D Curve and Spline parameter nodes remain associative to their parent element in ARCHICAD.
After editing the referenced element in ARCHICAD, press the ‘Send Changes’ button on the
Grasshopper Connection Palette to update the information stored in the 2D Curve or Spline
parameter node.

Note: The AC 2D Curve and Spline parameter nodes are compatible with the GH Curve
parameter. Thus, they can be used as the input for any GH component that accepts the GH curve
type as an input.
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Naturally, you can use the 2D Curve or Spline Parameter nodes to reference multiple ARCHICAD
Polyline, Spline, Line or Circle elements. To do this, use the “Set Multiple 2D Curves” command
from the context menu.
Note: If any ARCHICAD elements are selected at the time you issue the “Set Multiple 2D Curves”
command, and if the set of selected elements includes at least one element drawn with the
Polyline, Circle or Line Tool, then the parameter is automatically defined according to the
selected element, and no further element selection is needed.

Fill, Roof, Slab Parameter Nodes

Data in Fill/Roof/Slab Parameter nodes cannot be converted to native Grasshopper data types. For
this reason, Grasshopper operations (such as the Move component) cannot be carried out on them.

However, data of the Fill/Roof/Slab Parameter nodes can be used by the Reshape and Deconstruct
components.

Polygon
Slab
5& Slab Settings t
Synchronize

Geometry ﬂ Geometry
Curve

Circle

Plane

Radius

To add or change data in a Parameter node: use the commands from the context menu (e.g. “Set
One Roof”/“Set Multiple Roofs”), as described for 2D parameter nodes, above.

Note: The Roof Parameter Node can reference only Single-Plane Roofs in ARCHICAD (that is,
simple roofs consisting of a single plane). Roofs created with the more complex, Multi-Plane
Geometry method are currently not handled.
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Wall Parameter Node

Data of the Wall Parameter node can be used by ARCHICAD Connection’s Deconstruct Wall
component and by the Door/Window-type Design components.

~, Curve
wall | é :
¥ Wall settings
[« Synchronize

q wall
d h Insertion Point
D Door D
Orientation

[« Reveal Side

( Door Settings

To add or change data in a Parameter node: use the commands from the context menu (e.g. “Set
One Wall”/“Set Multiple Walls”), as described for 2D parameter nodes, above.

Other 3D Parameter Nodes

Data of other 3D Parameter nodes - Beam, Column, Curtain Wall, Door, Mesh, Morph, Object, Shell,
Window and Zone - can be used only by the corresponding Deconstruct components.

To add or change data in a Parameter node: use the commands from the context menu (e.g. “Set
One Beam”/“Set Multiple Beams”) as described for 2D parameter nodes, above.

Modify Information Stored by Parameter Nodes

The content of Parameter nodes in ARCHICAD can be redefined, deleted or updated at any time. To
redefine the stored value, use the “Set One Element” or “Set Multiple Elements” commands from
the context menu.

See description at AC Point Parameter Node.

e To clear the parameter values entirely, use the “Clear Values” command from the context menu.

e Information stored in a Parameter node is not updated automatically if the R —— |
referenced element has been changed in ARCHICAD. To update the GH code with  connecedto: unnsmea
changes made in ARCHICAD, click “Send Changes” on ARCHICAD’s Grasshopper
palette.

Break Connection
Send Changes

Select in GH
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The Synchronize Parameter

All AC components that generate ARCHICAD elements (Document and Design components) include

“Synchronize” as an input parameter. It is a Boolean type parameter which enables components to
communicate with ARCHICAD.

If a component’s Synchronize parameter is set to TRUE, changes made to that component will be
synchronized with ARCHICAD automatically.

If Synch is set to FALSE, the component will not generate any element, and will return a single
“Null” value, regardless of the number of input parameters.

| |

Synchronize @ Synchronize
Curve % Beam Synchronize with ARCHICAD
. TRUE =ct made to the will be synchronized with ARCHICAD automatically.
Beam Settings FALSE = the component does not communicate with ARCHICAD

One locally defined walue..
Trus

Note: Synchronization works only if ARCHICAD’s Grasshopper Connection is on: that is, the
green icon on the Grasshopper Connection Palette is spinning.

Tip: You can attach a single Boolean Toggle node to the Synchronize parameters of several
components (as shown in the illustration below). This way, you can control the Grasshopper-
based connection to entire parts of a building via a single toggle. Just switch the Boolean Toggle
to FALSE to turn off the synchronization function for those parts of the building that are not
being modified. As a result, working with Grasshopper-ARCHICAD Connection becomes more
efficient: only the affected parts of the model are recalculated.

Boolean Toggle

Synchronize

Panel
Ancher Point
) U Column D
End Point o
Column Settings
Synchronize
p {0}
C[ @ F Curve [j Wall ; 5
¢ Wall Settings
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ARCHICAD Document Components

Document components generate 2D documentation elements in ARCHICAD. There are
three Documentation components so far: the 2D Curve, the 2D Fill and the 2D Spline
component. All of them have two required input parameters: the Curve parameter
defines the shape of the newly created planar element, while the 2D Viewpoint parameter
determines the 2D Viewpoint (Section, Floor Plan etc.) of ARCHICAD onto which the new element
will be placed.

N 4%

Note: ARCHICAD’s documentation elements — such as those created by the Fill, Line, Circle,
Spline and Polyline tools — are not visible in 3D views, only in 2D views (Floor Plan, Section,
Elevation, Interior Elevation, etc.). Therefore, only 2D viewpoints can be used as the input
parameter for the 2D Curve and 2D Spline Components.

Choosing the Viewpoint:

1. Place a 2D Viewpoint Input Node, then connect it to the “2D Viewpoint” input parameter of the
2D Curve or Fill component.

2. Click on the right side of the 2D Viewpoint Input Node. A tree structure appears, corresponding
to the ARCHICAD project’s Project Map.

3. Choose the desired Viewpoint, then click Select.
See also 2D Viewpoint Input Node.

( Synchronize

Synchronize

Fill Settings (Ere R @ GEanEd
Curve

Note: The 2D Curve and Fill components will accept only curves lying on a single plane as inputs.
The input curves defined in Grasshopper can also be planar splines, but ARCHICAD will segment
these, creating segmented Polylines.

At present, it is not possible to attach additional GH components to the right side of Document
components (e.g., you cannot transform them with the Move component), because the data
output by the Document components are not recognized by the GH components. However, Fill-type
data created with the Fill component can be used as input by Reshape components (Add/Subtract
Polygon).
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2D Curve Component

This component generates curves (defined in Grasshopper) in a selected 2D Viewpoint of the
ARCHICAD project. The curves created in ARCHICAD will be Polylines. If you want to define the
ARCHICAD Layer, the Line Pen or Line Type of these Polylines, attach a Polyline Settings component
to the Settings input parameter of the 2D Curve Component.

Navigator - Project M... n

XN ey
4 (M Untitled "
a7 stories P—
Y 2. story ‘i; . ynchronize
[ 1. story . Curve
[5 0. Ground Floor
£ Sections
77 Elevations
[0E] interior Elevations
Waorksheets
(D petails o

< >

a 2D Curve

2D Viewpoint
Polyline Settings

2D Spline Component

This component works the same way as the 2D Curve Component, except that it generates Spline
elements in ARCHICAD. The Spline Settings component, in addition to Pen and Layer options,
includes two Boolean (TRUE/FALSE) options: you can choose to generate a normal vs. Bézier curve,
or Open vs. Closed-ended Spline.

Layer, 2D Drafting - General
Curve X
/L spline

2D Viewpoint

[ T% | 0.Ground Floor P

Spline Settings
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2D Fill Component

The Fill component will create Fill elements (that is, 2D hatches) in ARCHICAD. Like the 2D Curve
component, the Fill component has two required input parameters: a Polygon (defined by a planar
closed Curve-type or planar Surface-type geometry) and a 2D Viewpoint.

Use the Fill Settings component to define the attributes of the generated element (use the Pen,
Line Type and Fill Pattern parameters), its Layer (use the Layer parameter), and/or to show its Area
Text.

Plane -
olygon D
Radius e

Segments
. X Length -
Fillet Radius { Synchronize
Polygon
[(T3| 0.Ground Floor P 2D Fill
0 round Moo q 2D Viewpoint %
Fill Settings

Note: Right-click the Fill Settings component
to open the context menu, where you can
define the Fill category of the newly created
Fill element. If you choose “Cut — Building
Material”, then you can use the Building
Material parameter (instead of the Fill
Pattern) to define the pattern of the Fill

Fill SetM &

Enabled
& Bake.,

element to be created in ARCHICAD. | Cotegoryor ARCHCAD P s | % vaing
@ Hep.. P Cover
Cut
e Cut-Building Material
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ARCHICAD Design Components

The Design components generate native 3D elements in ARCHICAD
Their input parameters must be geometric information (point, curve, = Elgij( Ex @@d}:’ < B
etc.) which define the new elements’ position. Most of them have a I = G0 O [
single output parameter which stores geometric information. EEE [ C%G’ 5,

The outputs of AC Design components currently cannot be used as
inputs for the transforming components in GH (such as Move). For some
components, however, the output data can be re-used as inputs for other AC elements (for
example, the Window component requires a Wall-type input; the Reshape components accept Fill,
Slab and Roof type inputs).

( Synchronize { Synchronize
Curve G Roof Single-plane Geometry ﬂ Geometry
( Roof Settings (¢ Curve

Synchranize q Synchronize
Curve & > slab wall

; : B Window
Slab Settings ( Horizontal Distance

¢ Window Settings

synchronize
Synchronize
Curve D Wall ¥ !
; Wwall
Wall Settings D Dot
Horizontal Distance
Door Settings
Synchronize

Curve =3 Beam D

Important: If a Grasshopper component (e.g. Slab) is assigned multiple curves as input
parameters, then ARCHICAD will generate a corresponding number of Slabs, each of which is
separately editable in ARCHICAD.

To refine a Design component’s geometry or attributes, you can attach the corresponding Settings
component. By default, Settings parameters initially inherit the values set in ARCHICAD (in the Tool
Default Settings dialog of the corresponding tool). In Grasshopper, use familiar methods to override
these default values (e.g. attach a Number Slider component).

See ARCHICAD Settings Components for details.

Building Material

( Synchronize
Height Curve D Wwall
i © 0.250 : Thickness ¢ Wall Settings

[©] outside slant Angle

q[©] nside slant Angle
[ﬂl'tg <& ARCHICAD Layer ]
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Note: Many ARCHICAD-based parameters of design elements are not yet available for
Grasshopper’s AC components. The value of these parameters, at the time the component is
first generated, will equal the current default value set for the corresponding tool in ARCHICAD.

Column Component

The AC Column component requires two points as input parameters. Based on these, Grasshopper
will generate ARCHICAD columns along the defined segments (which serve as the column axes).

Column (Locked)
Structure: GENERIC - STRUCTURAL
Base Bevation: 0

W/D: 300 / 300

Layer: Structural - Bearing
Story: 0. Ground Floor

Synchronize
Anchor Point
End Point
Column Settings

U Column D

Connect a Column Settings component to the Column Settings input parameter to control the

Building Material, Layer and additional geometric parameters.

Through the context menu of the
Settings component, you can define the
column profile (Rectangular, Circular or
Complex Profile).

Notes:

o You can also attach an AC Point
parameter to an AC Column
component, because AC Point
data is compatible with GH Point
data.

o Defining the end point of the
Column is optional. If you leave it
undefined, you will get a straight

ColumnSetR &5

Enabled
\;;5 Bake...

Structure of ARCHICAD Column

]

@ Help...

Rectangular
@ Circular

E Complex Profile

column with default height (the current height set in the Column Default Settings dialog in

ARCHICAD).
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Slab Component

The AC Slab component generates an ARCHICAD Slab element. The required input parameter is one

or more closed polygons defined by the planar surface of Curve type data. Because ARCHICAD can

interpret only horizontal slabs, the input polygons must be in the XY or parallel plane.

The input geometry may be:

e a Grasshopper Curve parameter referencing one or more selected closed curves in Rhino,

e a Grasshopper Surface parameter referencing one or more planar surfaces which may also have
holes in them,

e any closed planar Curve or planar Surface geometry generated by a Grasshopper Component,

® a 2D Curve parameter referencing a closed ARCHICAD polyline element.

( Synchronize
1| ( Polygon &> slab
( Slab Settings

- Synchronize
ane
Polygon Polygon & > Slab
Radius @ S
ab Settings
Segments g

. . Length
Fillet Radius

0 Synchronize
Polygon & > Slab

( Slab Settings

Important: In Rhino, you can select a curved spline as the input parameter for the AC Slab
component, but the outline of the corresponding Slab generated in ARCHICAD will be
segmented.

Use the Slab Settings component to access additional parameters. Open its context menu to define
the Structure (Basic or Composite) of the generated Slab elements; the set of available input
parameters will change accordingly.
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Wall Component

The AC Wall component generates ARCHICAD Wall element(s), based on one or more lines,
polylines, or open or closed curves. The input geometries must be in the XY or a parallel plane.

d Synchronize
(@ > d curve [ wall D
q Wall Settings

q PointB o Plane

¥y

{ Synchronize

.0
Slant Angle 1: 50,00°
Slant Angle 2 130,00°
Thickness: 300

Height: Linked to 1. Story
Layer: Structural - Bearing
Story: 0. Ground Floor

{ Synchronize
.(E,- d Curve D Wall D
¢ Wall Settings

Important: If you select a Rhino spline as input curve parameter for the AC Wall component,
then the resulting element in ARCHICAD will not be a single curved Wall, but rather a chain of
Walls, whose segments correspond to the spline segmentation.

To access additional parameters — such as Layer, Height or Building Material — connect a Wall
Settings component to the Wall Settings parameter.

The Structure (Basic, Composite or
Complex Profile) and Geometry
Method (Straight or Trapezoid) of the
generated Wall elements can be set
through the Wall Settings component’s
context menu. Depending on these
Structure and Geometry Method
values, the rest of the available
parameters will vary.

WallSetB

Enabled

Bake...

Structure

-

Basic

Geometry Method of ARCHICAD Wall 3 JEI Composite
J& Complex Profile

Help...
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Beam Component

The AC Beam component generates ARCHICAD Beam element(s) along one or more lines, polylines,
or open or closed curves. These curves may be in 3D space.

¢ Synchronize

Curve "y Beam [
=
( Synchronize

Curve =3 Beam [
( Beam Settings

Beam (Selected) (Locked)

Layer: Structural - Bearing
Sowy: 0. Ground Floor

=

Important: 3D curves will be segmented in ARCHICAD. Therefore, the geometry generated by
the AC Beam component will produce not a single curved Beam, but rather a chain of beam
segments.

Attach a Beam Settings component and
open its context menu to decide what
kind of cross-section the generated
Beam elements should have
(Rectangular or Complex Profile).

Based on this choice, the Settings
component will contain further
parameters, such as Profile Rotation,
Axis Offset, and Building Material.

BeamSetP &

Enzbled

Bake...

Structure of ARCHICAD Beam 3 | Rectangular

Help. Complex Profile
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Morph Components

There are two kinds of Morph components:

e The Morph Curve component transforms the Curve from Rhino into an ARCHICAD Morph curve.

e The Morph Solid component transforms Mesh geometry from Rhino into a solid ARCHICAD
Morph.

¢ Morph Settings

" chee
: « Synchronize
Q || « Curve @ Morph

Synchronize
Mesh G\@ Morph

( Morph Settings

q @ P‘j ‘?’EP . RIS I; j synchronize
Settings Mesh Morph
Settings
Wire Display 5

Principal
Reverse
Flatten
Graft
Simplify
b Set Mesh Options

Manage MeshParameters collection

BEPED®

Clear values
Internalise data

Extract parameter

@ Help.

With the help of the Morph Settings component, you can assign a Building Material to your newly
generated Morph element, and you can decide which ARCHICAD layer it should appear on.

Note: In Grasshopper, you can also use Box, Surface, or BREP-type values as Mesh inputs for a
Morph - since these values are converted into the Mesh type automatically. When using BREPs,
it is recommended to also use the “Mesh-Brep” converting component in GH, to help keep
polygon count under control.

Note: The Weld Edge information is stored in the Morph component. Thus, the Weld Edge
information applied to the input Mesh will also be applied to the Morph element generated in
ARCHICAD.
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Roof Component

The Roof component requires a planar polygon input geometry for generating an ARCHICAD Single-
plane Roof. This input polygon may be defined by a Curve-type or Surface-type data that can lie in
any plane, thus defining not only the Roof contour but also its pitch and elevation.

| Roof (Locked)

| Structure: Tile - Roof

| Pt Line Bevation: -330
| Roof Pitchx 24447
Thickness: 330

Lajer: Shell - Roof

Story: 0. Ground Floor |

You can determine the Structure type (Basic or Composite) of the element through the context
menu of an attached Roof Settings component. Depending on the selected Structure value, the
Settings node will include Composite or Building Material as an input parameter.

Note: The planar curve or surface used for the polygon input defines the 3D location and plane
of the Single-plane Roof element generated by the Roof component. Thus, the Offset from
Home Story and Roof Pitch parameter values (stored in the Favorites of the Roof Settings input)
have no effect.

- = l
/) Roof Selection Settings :
kg Selected: 1 Editable: 1

~ DI GEOMETRY AND POSITIONING

::::1 B w

Home Story:

0. Ground Floor W % Generic Roof/Shell ]
bl
l
. _toProject Zero ¥
- /% G
» £]> MULTI-PLANE GEOMETRY
] Jg' FLOOR PLAN AND SECTION
v » MODEL
L4 CATEGORIES AND PROPERTIES
> Shell - Raof 3 Cancel
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Shell Components

The ARCHICAD Shell tool has three Geometry Methods - Revolved, Extruded, and Ruled. ARCHICAD
Connection provides a separate component for each. Each component has two required input

parameters, whose type is either Curve, Vector or Axis.
Synchranize
| comamian 254 P
g Shell Ext, Settings

Shell (Locked)

Structure: Generic Wall/Shell @Do@\;ﬂ Generic Wall/Shell D

Absolute ARitude: 0

Layer; Shell - General
Story: 0. Ground Floor

o q Synchronize
‘m. q First Profile Curve
A shell
( Second Profile Curve
ll ( Shell Ruled Settings
Plane
Radius Synchronize
Profile Curve
( Segments @ {ﬁ) Shell

Revolution Axis

q Fillet Radius

Shell Rev. Settings

Each of the three Geometry Methods has its own Settings component. Use the Settings component
context menu to define the generated element’s structure: Basic or Composite. In addition, you can
use the Settings parameters to fine-tune the Shell geometry or define its Building Material/
Composite attribute.
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Mesh Component

This component generates an ARCHICAD Mesh element based on the 3D coordinate set it receives
as input. The input must consist of a set of at least three points.

Use the Mesh Settings component to define Building Material, Height, and Layer. Use the Structure
input to set the Mesh display as either Solid or Surface only.

Mesh (Locked)
Base Hevation: -1000

Building Material

Height

Structure

Layer
A0 .

D = Mesh Settings ]

Layer: Site & Landscape - Terrain
Story: 0. Ground Floor

Synchronize

Points
. Mesh
Mesh Settings

Boundary

Curtain Wall Components

To generate a Curtain Wall element from Grasshopper, you can use three different components.

Curtain Wall component: Generates a Curtain Wall by an extrusion of the reference line (defined
by the Curve input). The extrusion is perpendicular to the plane of the Curve input. The height
of the generated Curtain Wall is defined in the Domain input, and its External Side is defined by
the point-input value of the same name.

Curve

Domain il Curtain Wall

Note: Use the Construct Domain Grasshopper component to define the Domain input
parameter. If the Domain Start parameter value is negative, then the extrusion will also extend
below the reference line (in the negative Z direction). Example: If the Domain value is “-2 to 3”,
then the generated Curtain Wall will be 5 meters in height, and will begin at a point two meters
below the reference line.

Curtain Wall Segment component: Works similarly to the Curtain Wall component, but here you
can only create a single Curtain Wall segment (its input reference line is a Line, rather than a
Curve). The component also requires a Plane Point input parameter. The extrusion takes place
perpendicular to the reference plane defined by the Line and Plane Point inputs. The Plane Point
also defines the Curtain Wall External Side.
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Line input: reference line of Curtain Wall

Plane Point input: point defining
(together with the reference line)
the reference plane of the extrusion.

Reference plane (the extrusion takes
place along the normal of this plane)

XY plane

Plane Point ;
- @ Curtain Wall 5
Domain

e Curtain Wall Boundary component: Generates a Curtain Wall element with a Boundary of a
freely defined shape. Its plane and shape are defined by the closed polygon given as the
Boundary input parameter. Here, too, an input point defines the External Side.

¢ Synchronize
{ Plane —
Circle Eeincag i
ol Curtain Wall
I External Side E.L!
¢ CW Settings

The Curtain Wall Settings component can be attached to any of the three CW components. Further
Settings components can be attached to these as needed:
e Use the CW Scheme Settings component to define the grid pattern of the Curtain Wall Element.

e Use the CW Frame Settings component to set parameters for Mullion, Transom and Boundary
frames.
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e Use the CW Panel Settings component to set parameters for the Main and Distinct panels.

(| Plane -
Circle D { Synchronize
( Radius . .
- d Boundary X
: @CunamWall
,“, q External Side

( Cw Settings

Zone Component

The Zone Component generates spatial units in your project, to represent rooms, wings of a
building, blocks of a housing estate, or functional areas. ARCHICAD Zones in 3D can also be used for
simple mass modeling; and they also form the basis of the Model Review process in the Energy
Evaluation function.

A Zone Component requires two inputs: the Curve input determines the Zone’s shape, while the
Stamp Position defines the location of the Zone Stamp.

The content of the Zone Stamp can be defined using the Zone Settings component. Connect
additional inputs to Zone Settings to assign metadata and attributes.

See the sections on The Property Settings Component (Controlling Metadata) and the Zone Category

Input Node.

g Vertices

’ l .

q Closed
( Curve

. E’J Zone )

( Stamp Position
( Zone Settings

I o

E4

Note: By default, Zones in ARCHICAD are visible only on the Floor Plan. To see them in the 3D
window, go to View > Elements in 3D View > Filter and Cut Elements in 3D, and check the Zone
item under “Element Types to Show in 3D”.
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B Filter and Cut Flements in 3D ?
Stories to Show in 3D
(®) Infinite
() Limited: To | 2. Story
From 0. Ground Floor

Trim Elements to Story range

Marquee Effect

Show Elements: @Inside Marquee
(O) Qutside Marquee

[] Trim Elements to Marquee

Cut Surface Display
@ Use Element Attributes
O Custom

o

Element Types to Show in 30
Window
Door
Skylight
Object
Lamp

Slab

Mesh

Roof

Shell
Curtain Wall
Zone
Marph

Stair

|

APVSREL 904> ¢d
0N INIEEEEEE

Railing

<

Cancel

Object Component

AC Object components require a single input parameter: anchor point. The default Library Part type
depends on what is set in Object Default Settings. To place a different object, attach an Object
Settings component, and use “Select ARCHICAD Library Part” from the context menu. This
command is available only if you have activated the “Use existing Library Part” option in the same
context menu, as shown here:

Object (Locked)

Mame Armchair 0120
Base Hevation: 0

Layer: Interior - Furniture
Story: 0. Ground Floor

Synchronize
Anchor Point ﬁa Object
| Object Settings

ObjSet Existing

Enabled

| &

o=

Bake...

Create new Library Part

Use existing Library Part

Ble®

Select ARCHICAD Library Part

©

Help...

See also The Object Settings Component (Selecting or Creating Library Parts).
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To allow Grasshopper to access the Library Part’s internal parameters, you must modify its program
code.

Note: Library Parts are programmed using a code called “GDL” (Geometric Description
Language.) For details, see https://en.wikipedia.org/wiki/Geometric_Description Language.

Window and Door Components

Door/Window elements in ARCHICAD can only be placed into existing Walls — they cannot “float”
independently of a Wall. Thus, Door and Window components require a Wall-type input.

To create the Door/Window opening, the input data must include information on its location
relative to the host Wall’s reference line. You can define this in two ways: via distance or a point.

e The Horizontal Distance component defines the distance between the Door/Window insertion
point and the Wall's endpoint, along the Wall reference line.

e The Door/Window Point component defines the location of the Door/Window opening as a
point projected perpendicularly onto the Wall reference line.

| Window (Locked) |
Name, Window 20
W/H: 800 / 1500

Sillto Story 0: 1000 . 1 Synchronlze
Story: 0. Ground Floor | || .
( Wall Settings

Synchronize

Wall

E Window

( Horizontal Distance

Window Settings

As described for the Object component, attach a Door/Window Settings component, then open the
Select ARCHICAD Library Part dialog to choose an opening.

Note: Doors and Windows, like Objects, are Library Parts programmed in GDL (see above). For
more information, see Accessing GDL Parameters of ARCHICAD Library Parts.
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ARCHICAD Deconstruct Components

Use the Deconstruct components to extract information from existing

' 1
ARCHICAD elements: their reference geometry which determines their Gy~ 9‘ I f "R g 9‘ ;?*
position, and their Settings. 1—9: 1J9: S /9: AgEEN
Deconstruct components are the inverse of the element-generating Hi‘:' '9: ’iﬁ : [-9:

(Document and Design) components: output parameters of Deconstruct
components are the same as the input parameters of the element-generating components. (The
Synchronize parameter, which enables or disables synchronization between Grasshopper and
ARCHICAD, is an exception: this parameter is missing from Deconstruct components.)

While Deconstruct components can be applied to data generated by the Design and Document
components, they also work on manually placed ARCHICAD elements. To refer to a placed
ARCHICAD element: right-click on the input parameter or corresponding Parameter node to open
the context menu, then choose the “Set one Element/Set Multiple Elements in ARCHICAD”
command.

Note: The Deconstruct Roof component can reference only Single-Plane Roofs in ARCHICAD
(that is, simple roofs consisting of a single plane). Roofs created with the more complex, Multi-
Plane Geometry method are currently not handled.

Slab. S Polygon 1:
4 5 h R siab Settings [

Slab &y

Preview

Enabled
Bake...

¢ BE

Wire Display 3
Disconnect 3
Reverse

Flatten

Graft

Sirmplify

HEEE

Set one Slab in ARCHICAD

Set Multiple Slab in ARCHICAD
Clear values

Internalise data

Extract parameter

‘_) Help...

If the referred element is modified in ARCHICAD, click “Send Changes” on ARCHICAD’s Grasshopper
palette to update the GH code.

To access detailed information on the settings of the input element, go to the Deconstruct
Component’s Settings output node, and attach the Extract Settings component to it.

See ARCHICAD Extract Settings Components, below.
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ARCHICAD Settings Components

Use the Settings component to define the parameters and attributes of the new ARCHICAD
element generated by a Document or Design Component.

Each Document and Design Component includes a Settings parameter. & AN A _ou an an
it SETES S &~
Two types of components can be attached to it: P = S S

0 # &2 A ¢ W [J

e Favorite Input Node: Use this if you want to control all of the new M A A AN AN &N A
element’s parameters from Grasshopper (see Input Node for more
information). ——

e Element Settings Component: Use this if you want to control only certain of the new element’s
parameters from Grasshopper. Attach the corresponding element Settings component (Wall
Settings, Slab Settings, etc.) to the Settings parameter.

Using the Element Settings component is not mandatory. If you do not use it, then the newly
generated element will use the current Default Settings of its corresponding tool in ARCHICAD.

The right side of the Settings component has a single output parameter, which transfers the input
data to the Design or Document component.

In many Settings components, you can change the structure or type of the generated element,
using a context menu command. As a result, the set of input parameters available to the Settings
Node will change (that is, new parameters will appear on the left side of the node, and others are
removed).

Any upstream nodes that were formerly connected to a removed parameter will be disconnected.
Disconnecting nodes is not undoable. Therefore, the program displays a warning when you issue a
command that will remove an input parameter. To avoid disconnecting nodes, you can press Cancel.

Building Material
Height
Thickness
[©] Outside Slant Angle
@ Inside Slant Angle
&
Layer Dﬂ Wall Settings.
[[3]
Structural Function [WallSetB I Break Connections
Pasition [@] Enabled
Renovation Status 2 Bake. L

Number Slider ©0.250

Asthe result of changing the Structure, any nodes
comnectedto the following inpLt parameters wil be
disconne cted:

Pi Setti
roperty Settings Structure 3 ‘ Basic -lEmEs
Geometry Method of ARCHICAD Wall  » || [l Composite
- Jh ComplexProfile Cancel
@ Help..
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The Object Settings Component
(Selecting or Creating Library Parts)

Like other Settings components, the purpose of Object Settings is to define the ARCHICAD elements
generated by Grasshopper.

The Object Settings component lets you define the Library Part in two ways, from the context
menu:

e Use existing Library Part - Choose an existing Library Part from the ARCHICAD project
e Create a new Library Part, whose geometry is defined in Grasshopper.

Use Existing Library Part

First activate this option in the context menu (as shown below).

The Select ARCHICAD Library Part command is now available: click it to bring up a dialog. On the
left side, choose an existing Library Part. On the right side, the selected object’s internal parameters
are displayed for your information.

Object (Locked)

Mame Armchair 0120
Base Hevation: 0

Layer: Interior - Furniture
Story: 0. Ground Floor

Synchronize

Anchor Paint Ha Object

ObjSet Existing

Enabled

Bake...

Create new Library Part

Use existing Library Part

Ble ¢ ®

Select ARCHICAD Library Part

Help...

e

On the left side of the appearing dialog box, choose among the ARCHICAD project’s loaded library
parts. On the right side, the selected object’s internal parameters are displayed for your
information.

Note: By default, Grasshopper cannot access the internal parameters of ARCHICAD Library Parts
- they are grayed out on the interface. To allow Grasshopper to access the Library Part’s internal
parameters, you must modify its program code.

See Accessing GDL Parameters of ARCHICAD Library Parts.
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Create New Library Part

This option lets you create a new Library Part, which will be placed in the Embedded Library of the
connected ARCHICAD project.

With this option activated, two additional input parameters appear on the left side of the Object
Component: Geometry and Object Name.

M| Object Default Settings ? X
'
R ] E— R
v [ Embedded Library A~ DI PREVIEW AND POSITIONING
v B Grasshopper =
) o S T T = p

y

v Linked Libraries Home Story:

~ B arcrican Library 21 0. Ground Floor (Current)  ~

~ [ 1. BASIC LIBRARY 21

4 {

/ ~ |

. \

f \

to Project Zero [¥
« B 1.7 Fumnishing 21 ~ . :
- \
Hﬁ Relative [¥

u% 315,007 O @&

» RHINO IMPORT OBJECT SETTINGS
+ [Z FLOOR PLAN AND SECTION

+ (91 mopEL

» CLASSIFICATION AND PROPERTIES

d  synchronize
d Anchor Paint Ea Object b
d Object Settings

Q@E@bo

freeform shape|

s < Interior - Furniture ’ Cancel

Use the Geometry parameter to input the shape of the new Library Part.
Note: You can add multiple shapes as input Geometry. Grasshopper handles all the inputs as a
list, and uses them to generate a single complex Library Part. Whenever this Geometry data is
modified in Grasshopper, the resulting Library Part is modified accordingly.
You can use the newly created Library Part immediately: as an input parameter for the Object
generating component (in Grasshopper), or place it in the ARCHICAD project with the Object tool.
If you delete the Object Settings component in Grasshopper, the created Library Part will also be
deleted from ARCHICAD’s Embedded Library.
The same happens if you switch the Object Settings component to “Use existing Library Part”: the
generated Library Part is deleted from the Embedded Library, and any placed instances will be
missing Objects in ARCHICAD.
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The Property Settings Component
(Controlling Metadata)

The Property Settings component provides access to the metadata (e.g. Properties and
Classifications) defined for ARCHICAD elements. With this component, it is possible to assign
Element Classification to ARCHICAD elements or overwrite their Property values in Grasshopper.

Note: Use ARCHICAD Properties to add optional descriptive data to a building element. In
ARCHICAD, you can list and manage Properties in the Interactive Schedule, display them in
Labels, Zone Stamps, Door/Window Markers, import and export them among applications or to
spreadsheets. Use the Property Manager (Options > Property Manager) to create and delete
properties and customize their availability. Each element’s Properties are shown in the
Classifications and Properties panel of Element Settings. Classification is also used to map
Properties when exporting to IFC. ARCHICAD supports any number of national or company
standard classification systems at the same time.

) Wall Selection Settings ? b Property Manager ?
T
e Selected: 1 Editable: 1 = Editable: 0
T|Q | wan v -
~ D! GEOMETRY AND FOSITIONING Name Type Default
~ GENERAL RATINGS +
wall Top: T
+ Fire Resistance R... Option Set 25 minutes ~ DEFINITION
1. story (Home - 1) v | AR B ¢ Combustivle  Trug/False False
 Thermal Transmit... General Undefined elayiee
Generic Wall/Shell >
s [0 [ Generic Walushe % Sound Transmiss. General x5
Preview/Default:
~ MAIN CONSTRUCTION +
o = e $ Construction Type Option Set Undefined P
4 iyt 00
Home Story
0. Ground Floor (Current] v
o Project Zero [») | Reference Line: » AVAILABILITY
; = o
d o | =9 = o
+ [ FLOORPLAN AND SECTION
» % mopEL

~| [E] CLASSIFICATION AND PROPERTIES

CLASSIFICATIONS
[] Show conflicts with Properties in Hotlinks

New., Delete N Cancel

ARCHICAD Classification ...

- ID AND CATEGORIES "
D sw- 003

Undefined

Undefined

Existing =

iiter All Relevant Filters

a
@ Structural - Bearing » Cancel

When first placed, the Property Settings components has no parameters. To assign Classifications
and select Properties, use “Select Classifications and Properties” from the component’s context
menu. In the appearing dialog, first choose one or more Element Classifications: this will determine
which Properties can be assigned to the generated element.

Once the Element Classifications are defined, the dialog lists only those Properties that are available
for assignment. Check the box of the Properties you wish to assign, then click OK.

The selected Properties now appear as new input parameters on the left side of the Property
Settings node.
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Select Classifications and Properties E

‘Set Hement Classfication:
ARCHICAD Classfication - 21 Construction Hemert
Q|
= Construction Element ~
Beam
Search Propetties
(@l - Covering
| - Curtain Wal
Name Type 0 Focting
GENERAL RATINGS :i’"w
= Fre Resstance Fatng Opton 5 =
Enabled [ Combustible Tiue/False - Rafing
. [] Themmal Transmitance General - Ramp
& Bake. [] Sound Tranamission Class General - Roof
Shel
I Select Classifications and Properties MAIN CONSTRUCTION Slab
[] Construction Type Option Set Stair
@ Help.. Technology Option Set Wal
[] Concrete Cover at Main Bars General Opering
[ Class of Suface Option Set Massing
[ uting Wit General Blement Componert
Reirforcing Bement
ENVIRONMENTAL Furishing .
[] Life Cycle Environmental Integer
[ Environmental Class Integer Select I
[] Service Life Intsger S ‘ 3
[ cancet |

Elements generated by Grasshopper are automatically given the “Grasshopper Connection”
classification, which contains the “Grasshopper” Property group. This consists of two properties
describing the elements’ source data: a timestamp (the last time the element was refreshed
according to its source code) and the name of the Grasshopper source file (Grasshopper Source
Definition).

| ) Object Selection Settings ?
v Q| | ‘" Armchair 01 21 Selected: 1
4[] Linked Libraries ~ ~ D1 PREVIEW AND POSITIONING

4 [ ARCHICAD Library 21

S,
520 x 520
4[] 1. BASIC LIBRARY 21 .- &3 |£|
) W X X
4 [ 1.1 Furnishing 21 e H
D Appliances 21 | 0. Ground Floor [(Current) v|
D Bathroom Accessories 21 H
to Project Zero *
) Beds 21 . 1 L ®
|L| Cabinets and Shelves 21 A
IS 520 =
— * 53] >
] R h
o Relative [#]
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J » CHAIR SETTINGS
Armchair 01 21 Armchair 02 21 ' Eg ELOORTCANANDS N
» [ MoDEL
- CLASSIFICATION AND PROPERTIES
CLASSIFICATIONS
e
’ ARCHICAD Classification ... Furniture
m Grasshopper Connection... Grasshopper Element
Armchair 03 21 Armchair 04 21 & Service Life o ~
e Stored Eneray Undefined
= GRASSHOPPER
=t Grasshopper Source Defi... NO_DOCUMENT_SELECTED
S5 Last Updated by Grassho... 2017.02.23, 17:35:06
I = IFC PROPERTIES
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| @ Interior - Furniture v Cancel oK
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Note: Classifications are assigned to elements only if the name of its parent Classification
System name is checked. An element can be assigned Classifications from multiple Systems, but
only one Classification per System. Properties listed below are those of the checked

Classification Systems.

An ARCHICAD Property has one of six possible Data Ty

pes:

e General: Simple text; corresponds to Grasshopper Text

e Integer: A whole number; corresponds to Grasshopper Integer

e Number: Any real number; corresponds to Grasshopper Number
e True/False: Logical value; corresponds to Grasshopper’s Boolean

e Tags List: A series of words or phrases; used to make it easier to search for elements that use
such tags. In Grasshopper, this is achieved by assigning a series of Texts separated by semi-

colons.

e Option Set: A list of text values. The user can choose one or more of these defined options
(multi-choice). In Grasshopper, this is achieved by entering the number of the option(s) to be

assigned to the Property, based on the info shown

Property Manager
«
Eaitable: 1
Name:
Fire Resstance Rating
~ DEFINITION

Data Type: Option Set

Preview/Default: 25 minutes

v
Options Setup...

Undefined Description:
Undetined minutes
DDMMATY

B Number 000

~ MANUFACTURING +

Tags list 48 B

4 ProductionDate  General DDMMAYTY

¢ Manufacturer
b AVAILABILITY

# Country of Origin_ General
¢ Product Website  General

Undefined
www.graphisoft...
Undefined

DDMMAYYY

Add Remove

in the tool tip.

A0 Property Settings
Fire Resistance Rating ‘@ perty J
lement Classification

a Fire Resistance Rating

Options Setup

[] Allow muttiple choices

Note: Whether an Option Set is multi-choice or single-choice is defined by the user in
ARCHICAD, using the Data Type - Option Setup choices at Options > Property Manager.

If the Option Set is multi-choice, then the Property Settings component in Grasshopper will
expect multiple inputs in the form of “Integer as List”. (If you input multiple integers here, then
multiple values are assigned to the Property, and the Property Settings component generates
one output). If the Option Set is single-choice, then the Property Settings component generates

a separate output for each input Integer.

Note: It is not possible to create a new ARCHICAD Property in Grasshopper; you can only assign
values to existing Properties. If you need a new Property, you can create it from ARCHICAD’s
Options > Property Manager dialog. Grasshopper is immediately updated with this new
information: the next time you open the Select ARCHICAD Property dialog, the newly created

Property will be listed.

The Property Settings component’s first output parameter is “Property Settings” type. You can use

this as an input for the Settings nodes of 3D elements.
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The second output parameter is “Element Classification”. Use it to add a Panel node, so you can see
the name of the Element Classification chosen in the Property Settings component.

( Wall Settings
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ARCHICAD Extract Settings Components

Use the Extract Settings components to access the Settings data of ARCHICAD elements.

Extract Settings are the inverse of Settings: Extract Settings output
parameters are the same as the Settings input parameters.

As input, you can attach Deconstruct components to Extract Settings.
The output of Extract Settings is a fixed list of parameters. If a particular
output is not applicable to the given element geometry, then the output
value is “NULL".

For example: The output from the Extract Wall Settings component includes parameters for
Building Material, Profile and Composite. Yet any Wall element can have only one of these three
values, depending on its particular structure. The other two parameter values here are “NULL".

Generic
Wall/Shell

o

{0}
0|<null> b

{0}

0. Ground
Floor
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ARCHICAD Reshape Components

Subtract Polygon Component

This component is used to cut a hole of any shape into an existing Fill, Slab or Single-plane Roof
element. First, connect the element to be modified to the Geometry parameter. Next, using the
Curve parameter, define the contour of the hole as projected to the horizontal plane.

The output will be an element of the type defined in the Geometry parameter, with a hole in it.

.....

Curve

Radius

1O

Segments

Fillet Radius

Notes:

o The Curve input defines the contour of the hole as projected onto the horizontal plane.
Therefore, on a slanted Roof, the hole is created by intersecting the Roof with the straight
prism defined by the Curve input.

o If you input a Curve that falls outside of the element in which the hole is to be cut, then the
Subtract Polygon component will result in another copy of the element to be cut, in
unchanged form (no hole).

Add Polygon Component

This component works just like the Subtract Polygon component, except that it adds to the contour
of the Fill, Slab or Single-plane Roof, instead of subtracting from it.
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ARCHICAD Input Nodes

Input Nodes are special interface elements that reference certain data from the ARCHICAD project,
making these data available to Grasshopper. The referenced data are continuously updated. Input
Nodes can be attached to Settings components to control attributes — such as Building Material,
Composite, Pen etc. — or the destination Layer of the generated elements. An exception is the
Favorite Input Node, which can be attached (instead of a Settings component) to the main Design
or Document component.

An Input Node is divided into two parts: click on its left side to select the Node itself; click on its
right side to modify its stored data.

Layer Input Node &1 &> ARCHICAD Laver b

Layer Name Exdension ™

Use the Layer Input Node to bring up the ARCHICAD
layer set in Grasshopper so you can define the layer
where elements generated by Grasshopper should be
placed. The Layer selection palette also includes the
layers’ status (show/hide, lock/unlock and 3D display
mode). Sort the layer list as needed (click the top of
any list column) to make layer selection easier.

Interior - Partition

Inteior - Fumniture

Shell - Roof

Site & Landscape - General
Interior - Stair
Annatation - Structure
Dimensioning - Structure
Annotation - General

2D Drafting - Hotspot
MEP - HVAC

MEP - Blectrical
Dimensioning - Site
Annotation - Label
Marker - Section
Structural - Shear
Structural - Bearing
Structural - Combined
Intesior - Lamo

Nearly all Settings components include a Layer-type
input (except the Settings components of CW Panel
and CW Frame).

POROOOOODOROO000DO

rFreerFrPaeaaeIaaa
rErrrrrererrrrrews

Fill Pattern Input Node Corcs || Soka

Through this Node, the Fill Type attributes of the current ARCHICAD project are made available to
Grasshopper. At present, only the Fill Settings component can use this type of input. Use it to
control the fill pattern of elements generated by the Fill component.

Conarete Block
VECTORIAL FILLS
Scaleindependent
Synchronize W race Bick =
777 Masonry Block
Curve % 2D Fill BEFE] Structural Concrete
Pattern d 2D Viewpoint ! % Lightweight Concrete Plaster
Gypsum
Show Outline Fill Settings A Steel
Outline Type Brass/Bronze
[ ] Rubble
Outline Pen == Riid Insulstion
ZZ2 Vood
P Insulation 02
1 EM3
Solid + Dot8Dashed 777 Solid + Dashed
DotdDashed 4 Dashed
Double 1:4 F77Dauble 1:8
Triangular Grid S Triangles
Hexagonil e Grass
Facing Tile - Large Scals [ Rubble - Large Scals v
Cancel Select

Note: The Fill Pattern Input Node can be attached to the Fill component only if you have
category from the Fill
component’s context menu (because the Building Material already includes the fill pattern.) For
more information on Fill categories, see helpcenter.graphisoft.com.

selected an option other than the “Cut Fill — Building Materia
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Pen Input Node
p |I——r‘l 0| 0.35mm /099 Pt - Annotation - Markers
Accesses the Pen attribute set of the connected EEN s EEENENEENEN ]
ARCHICAD project. Currently, this Input Node is ================ = =
i i i i i ANEENEEENENEENEE B W

available for the Fill, Polyline and Spline Settings E  E EEE R EEERE B
Components. . . .

. AN .
Line Type Input Node ENEESEEEEEEE

Lists the Line Type attributes of the ARCHICAD s S
project. Currently, the Fill, Polyline and Spline
Settings components accept this type of data.

Surface Input Node

Accesses the Surface attribute set from the connected ARCHICAD project. Currently, this Input
Node is available for only the CW Frame Settings and CW Panel Settings components.

Building Material Input Node
Lists the Building Material attributes of the ARCHICAD project.

ll Bnck Structural
Common Brick & 720
,é Brick - Common Bond

l:‘ Air Space l:‘ l:‘ Air Space - Frame 2
. l:‘ Aluminium @ . Brick
72 Brick - Firish %
l:‘ Concrete l:‘ Concrete - Structural
@ . Concrete Block - Filler @ . Concrete Block - Structural
% l:‘ Fiberboard @ l:‘ Fire Procfing
[ GENERIC - ENVIRONMENT [ ] GENERIC - EXTERNAL CLADDING

I:‘ GEMERIC - EXTERNAL MEMERANE

I:‘ GENERIC - EXTERNAL FILLER

[ GENERIC - INSULATION [T GENERIC - INTERNAL CLADDING
- INTERNAL FILLER I:‘ GENERIC - PREFABRICATED
- STRUCTURAL [] Glass
% l:‘ Gypsum Plasterboard
l:‘ Gypsum Plasterboard - Waterproof m l:‘ Insulation - Fiber Hard
m l:‘ Insulation - Fiber Soft m l:‘ Insulation - Mineral Hard
EZ3 l:‘ Insulation - Mineral Soft % l:‘ Insulation - Plastic Hard
% l:‘ Insulation - Plastic Soft . Insulation - Themmal Break
l:‘ . Iron E . I'~'1E|50nr1.r Block: - Filler
m . Masonry Block - Structural brane - Rainproof A

Cancel Select

Most Settings components of 3D elements include this type of input. Elements that can have
composite or profile structures (Wall, Slab, Shell, Roof, Beam, etc.) will include the Building
Material Input Node only if the Structure value is set to Basic. If the Structure value is set to

Composite or Complex Profile, then the Profile or Composite Input Node will be available instead.
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Profile Input Node

Enabled

Bake...

Synchronize
Curve a Slab
_ Slab Settings
pess &

Structure of ARCHICAD 5lab

Help...

Basic

Composite

Lists the Complex Profiles defined in the ARCHICAD project. Use it to define the cross-section of a
Wall, Beam, or Column element that has a Complex Profile structure.

Q Precast Beam T

Click the right side of the Profile Input Node to
open the selection palette. Filter the list by using
the element type buttons at the top left corner of
this palette.

Click the button at the bottom left to display the
list by either Icon or List format.

Note: If all three element-filter buttons are
active at top left, then you will see the full list
of profiles. If only the Wall button is active,
then only the profiles available for Walls are
listed.

Synch

ronize

Curve % Beam

D Beam Settings

BeamSetP &y

Enabled

Bake...

Structure of ARCHICAD Beamn

3

Rectangular

Help...

EHQ Precast Beam T b :

@ Complex Profile
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Composite Input Node

Lists the Composite attributes of the ARCHICAD project. Available in the Settings components of
Walls, Shells, Roofs and Slabs whose Structure is set (in their context menu) to Composite.

2D Viewpoint Input Node

Use the 2D Viewpoint Input Node to access the Viewpoints of the current ARCHICAD Project. By
attaching this node to the Document components (2D Curve, 2D Fill, 2D Spline), you can control the
2D Viewpoint in which the 2D elements should be generated in the ARCHICAD project. Open the
Node’s palette to access a tree structure corresponding to the ARCHICAD Project Map. Note that
only the 2D views are available (Section/Elevation, Floor Plan, etc.); no 3D views are available.

Mavigator - Project M... n

|l BI 0.Ground Floorb ® [E. o @

El- Untitled
- Stories a [P Untitled ~
E : Fl IE| Stories
5 1. story
= E!evations [ 0. Ground Floor
ﬁ Sections
; 4 Q Elevations
- West Blevation {7 East Elevation [Autc

T Morth Elevation [Au

1 South Elevation [AL

T West Elevation (Aut
E Interior Elevations
Warksheets

(B etails
30 Documents W
£ >
3 & X
Cancel Select D TS

Story Plane Input Node

Produces horizontal planes (parallel to the X-Y plane) based on the Story heights of the ARCHICAD
project. Use these planes to define the reference input curves of the element-generating
components: this way, the elements (e.g. Wall, Slab, Beam) will be generated in ARCHICAD at the
correct elevations.

lmb Plane Circle

Radius

synchronize
Curve & > Slab

! E % List of Stories b Slab Settings
No.  Name Elevation
2 Story 6
0 Ground Floor 0
Cancel Select
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Zone Category Input Node

Attach this Input Node to the Zone Settings component to define the Zone Category of the
generated ARCHICAD Zone element.

The main function of Zone Categories is to use colors to visually distinguish different types of spaces
in your project.

Synchronize

Curve [% E

( Stamp Position

Closed

Vertices
j F Polyline D

. .
0 GROSS AREA Zone Settings

1  Residential and Recreation
2 Office

3 Production & Research
4 Storage & Sales

5  Education & Culture

6 Medical Treatment
7

8

9

OO

|

Cther Usage
Technical Equipment
Communication & Access

I

| Cancel || Select

Favorite Input Node

Lists the set of Favorites of the ARCHICAD project.

Note: In ARCHICAD, the Favorites feature allows you to save sets of configured tool settings by
name. For more information, visit helpcenter.qraphisoft.com.

Unlike the other input nodes, the Favorites Input Node is attached not to the Settings Component,
but directly to the Document or Design Component (“Settings” parameter) which generates the
element. By attaching the Favorite Node (instead of a Settings component), you are thereby
defining all parameters of the generated element in one step.

Synchronize

Curve D Wall

Wall Settings

Structural Wall

D Show Wall Favorites "7%‘ Eallont=

Column Favorites

[ wall - Bent Shel
[} Wall - Foundation
Structural Wall
[} Partition Wal
[} Generic Interior Wall
] Generic Exterior Wal

Beam Favorites

Slab Favorites

Roof Favorites

Shell Favorites

Mesh Favorites
Morph Favorites
Window Favorites
Door Favorites

Object Favorites
Curtain Wall Favorites

Cancel | | Select | CW Frame Favorites

CW Panel Favorites
CW Scheme Favorites
Fill Favorites

PolyLine Favorites

SNNFECNRBrowadd a0y

Spline Favorites
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Note: The 3D position of elements generated by Grasshopper (such as the Offset from Home
Story parameter in the Settings dialog) are defined in the mandatory input data of the
Document and Design components, which generate the element. (For example, the elevation of
a generated Slab is determined by the Curve parameter of the Slab component.) Such
mandatory input data are not affected by Favorite settings.
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Workflow Examples

Example 1: Use Rhino to Create Freeform Shading System

In this workflow, we create the geometry using Rhino’s freeform modeling capabilities, while also
taking advantage of ARCHICAD’s BIM capabilities. The task is to design a shading system that
extends between two curved splines.

1. Begin in Rhino: create the 3D curved splines.
2. In Grasshopper, use these freeform geometries as the input parameter.

3. Use the Divide Component to generate the division points needed for the shading system.

Divide Curve

Curve defined in Rhino e —

Count f Tangents D
[ Number of Division Points | © 22 } s - ; y
- inks arameters

Divide Curve

Curve defined in Rhino ¢ & | P———
Count f Tangents D
Move Kinks Parameters )
Number Slider ( Geometry _o Geometry
Height of Facade | 22 Motion Transfarm
Untitled - Rhinoceros 5.0 Nat For Resale Lab - [Top] = C

File Edit WView Curve Surface Solid Mesh Dimension Transform Tools Analyze Render Panels VisualARGQ  Help
Curve or Edge to reference { Mode=Reference ).
Command: |

Top =

9.8, \'\N\‘
S¥-~
A
g 5
(4]
&‘ oe y
)
SE
Al X
T
Bm - .
oo Perspective . Top | Front . Right | <+
CPlane X277 y-8.75 z0.00 Meters [l Cefault Grid Snap | Ortho | Planar | Osnap = SmariTrack = Gumball Record History Filter CPU.

Splines drawn in Rhino with the Curve command
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4. At each division point, place an AC Column component; at each spline, place an AC Beam
component.

Synchronize
Curve =3 Beam

Beam Settings

Paints

Curve defined in Rhino ¢{ & :
MY b . .

C?unt f Tangents synchronize
Ll Anchor Point
End Point U S
Curve defined in Rhino { &) ) Collin Setings

Synchronize
Curve =3 Beam

Beam Settings

| i Untitled - GRAPHISOFT ARCHICAD-64 20 - 0 R
| File Edit View Design Document Options Teamwork Window Help — 8 x
O- 8 -@Exkarr 8 gsao- ,
: [S. Ground Floo [Posan x {7[South Elevation] Tandl
] Desigr
| B
|
(R0 ‘
(== |0 |
<=
=
=
M DG Q@ 2 |@Q curentzooms | & oo b |mm 1100 »|£F 02Drtting » | B Entire Model » | U 03 Architectu..» | 5] 03Building ... » | 0§ No Overrides »
Enter First Node of Wall, [_‘l:l

Generated BIM model in ARCHICAD based on 3D Rhino curves

5. You can fine-tune the geometry in Rhino by adjusting the original spline geometry (use the
PointsOn command).

6. To define the Building Material attribute or Core Dimensions of the generated Columns, attach a
Column Settings component to the corresponding parameter of the Column component.

Bi terial

Column Settings

Synchronize
Curve ©y Beam

/Elilde_c_un‘g Beam Settings Synchrenize
Curve Points Anchor Point

Count f Tangents t End Point ﬂ Column
q Kinks Parameters Column Settings

Divide Curve

Move Synchronize
Geometry Geometry Cutve 5y Beam
Notion Transform Beam Settings
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Example 2: Use ARCHICAD Input to Build a Parametric Tower

In this workflow, parametric design is based on an existing ARCHICAD project, using input that

originates in ARCHICAD.

The task is to create a mass model of a high-rise atop a six-sided base, which has already been

defined in ARCHICAD.

1. In Grasshopper, use the 2D Curve parameter node to reference the six-sided geometry in the
ARCHICAD project.

2. Create an array of the polyline to draw the outline of the slabs on each story.

Curve
Polyline defined
in ARCHICAD
Number Slider . Geometry
0 2.700 Unit vector . i
——

Y 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 - O R
File Edit View Design Document Options Teamwork Window Help -0 x
0o & g 2| B + - O~ o -[Em x| e HLG S -

[ o [0, Ground Floor] % [PED/an Eh -

2 Mt Building Site
~ Design i

Polyline
J wan 2 Type: Sofid Line
9 Layer: 2D Drafting - General

B Door o

Ea ‘Window lf

D Column f

B2y Beam

<> Slab

Connected to:

ParametricTower.gh

Break Connection ':3‘

Send Changes

Select in GH

P @Q|a 10% b O 0,00° b | i 1:100 v | & 02Drafting » | B  Entire Model » | | 03 Architectu...» | [3] 03 Building... » | T No Overrides

Click an Element or Draw a Selection Area. Press and Hold Ctrl+Shift to Toggle Element/Sub-Element Selection. ]

The cross-section of the tower is defined in ARCHICAD

3. Apply a rotation transformation to the array of polygons to create a more complex shape.
4. Use the rotated collection of polygons as the input parameter for an AC Slab component to

create slabs on each story, which can be adjusted as needed using the transformation features.
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5. Create division points along the slab outlines: these will constitute 3D curves.

Area
Curve
Linear Array =
UnitZ  Synchronize
02700 cEEIELY Geometry ) Curve &> slab D
B angle g ( slab Settings
Plane Transform
o4 Series
o6 b
fa 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 = = £
-8 x

File Edit View Design Document Options Teamwork Window Help

o | & L2

["510. Ground Floor] [Prosan x
Slab (Locked)
~ Design Structure; Generic Slab/Roof|
[j Top Elevation 19000
L Thickness: 300
Layer: Structural - Bearing
B Door . Story
H window Muttiple Elem ents (TAB)
U Column !
i
5=y Beam !
> slab
Connected to:

ParametricTower.gh

Break Connection’ @
Send Changes

yz x
1100 | £  02Drafting » Entire Model | |J 03 Architectu..» | [5] 03 Building ... »
=]

Select in GH
L)

DC AP & |@ cumentzooms | o 0,00°
Click an Element or Draw a Selection Area. Press and Hold Ctrl+ Shift to Toggle Element/Sub-Element Selection.

Slabs of the tower generated in ARCHICAD

BE=HEH#- v 0- 6 -Emx|earr rmaaseo-
Sinlid
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6. Use these curves as input parameters for AC Beam components to model the building’s twisting

frame.

Rotate

( Synchronize
Geometry Geometry ) Curve é> Slab
@ Angle F=—Y ( Slab Settings
Plane Transform

Interpolate Synchronize

Divide Curve Flip Matrix

Points Vertices Curve Curve QZ:} Beam
| Count f Tangents Degree a Length Beam Settings
Parameters Periadic
( KnotStyle Domain

i 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 - O IR
File Edit View Design Document Options Teamwork Window Help -gdx
o | @ F 2 [RFEFEM# - = v 0 - 5 -[Em x| ea |B2e® -
[™510. Ground Floar] [P sam x [Tt
1 Marguee p
7

* Design

[ wan
D Doar

E Window
- — Layes: Structural - Bearing

D Column Stony: 2. Story

i

I Mukiple Elements (TAB)
T Beam e fe—

e
j——t

<> slab

Connected to:
ParametricTower.gh

Break Connection ‘?_7\,'
Send Changes

Select in GH
» | & o2Dratting » | B Entire Model » | ) 03 Architectu..» | [E] 03 Building ..

<) Q‘Q F ‘Q Current Zoom ‘

Click an Element or Draw a Selection Area, Press and Hold Ctrl+5hift to Toggle Element/Sub-Element Selection. E

The division points along the slab outlines define 3D curves.
AC Beam components attached to these points create the twisted frame in ARCHICAD.

7. Atany time, you can edit the original six-sided polyline in ARCHICAD, thereby modifying the
cross-section of the entire high-rise: the 2D Curve parameter, the basis for the Grasshopper

code, remains associated to its parent element in ARCHICAD.

[51e. Ground Floon x [[Bo/AN W - _ [4910. Ground Flaor]
row

Building Site Marquee

i 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 -0 a 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 = =
File Edit View Design Document Options Teamwork Window Help —dx File Edit View Design Document Options Teamwork Window Help
= ;q;?,» i - O- 5 -BEx|wasC o 10 b O- R e
[JED/am x 0l

Marquee

~ Design ~ Design
[ wan O wan

[ poor [ ooor
H window (B window
0 cotumn a [ cotumn
=3 Beam Ty Beam
<> shab <> slab

Connected to:
ParametricTower.gh ParametricTower.gh

Break Connection| (1)

Send Chai Send Changes
Select in GH

Selectin GH
DCR@ mw e 0w »|[m 1w »[F ozpmmng »
=) Click an Element or Draw a Selection Area. Pre:

Break Connection| (5

o @‘Qr\@c ent Zoom » | 0,00° @ ot b

and Hold Ctrl+Shift to Teggle Element/Sub-Element Selectios ]

If you edit the original polygon in ARCHICAD, and then press the Send Changes button on the
Grasshopper Connection Palette, the model’s entire geometry is modified accordingly: the 2D Curve

parameter is associative to its parent element.
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8. To change the cross-section of a Beam, attach a Beam Settings component to the Beam
component’s Settings parameter. From the Beam Settings context menu, click on “Structure of
ARCHICAD Beam”, and select Complex Profile. As a result, the set of input parameters of the
Beam Settings input is modified and now includes the “Profile” parameter on the left side.

Beam Settings

e —

Enabled

Synchronize Bake...

Curve a Slab D Rectangular

Slab Settings R 1@ Hebp.. JE Complex Profile

Geometry Structure of ARCHICAD Beam

Transform

Divide Curve

Synchronize

‘ Curve 53 Beam

( Beam Settings

Curve Points

Count f Tangents
Kinks Parameters

9. Attach a Profile Input Node to the Profile parameter. Click on the right side of the Input Node to
bring up the Profile Selection palette, which lists all the profiles defined in the ARCHICAD
project. In the upper left of this palette, deselect the Wall and Column elements, so that only
profiles defined for Beams are visible, making it easier to choose the right one.

m% RHS Cold Closed
=1 (0]
RHS Cold Closed

120x120
. (S
I

S — "
Precast Beam | 01 Z Beam C Section - Lipped

L

C Section - Plain ~ Z Section Column Equal Angles

nist RHS Cald Closed T Steel A

| Concsl || Sekat |
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Parametric Behavior of Generated Elements

e Unlike geometry that is embedded using Rhino’s “Bake” command, elements generated in
ARCHICAD remain associated to their generating code. Grasshopper uses an ID-based method to
retain its connection to elements placed in ARCHICAD. If the Grasshopper file is modified, the
ARCHICAD-Grasshopper Connection Tool will update the corresponding elements in ARCHICAD.

e Elements generated by Design or Document Components in ARCHICAD are not just previews:
they are real, editable ARCHICAD elements. When Grasshopper creates these elements, their
status is locked. After you unlock them (Edit > Locking > Unlock), you can open their Settings
dialog in ARCHICAD in the usual way, and modify their parameters. You can also edit the
elements graphically.

a
File | Edit | View Design Document Options Teamwork Window Help

'] ") Unde Lock Selection / Ground Floor Ctrl+Z Q] - - éz“'t.{ [z x ‘ :*y@ A,
[} x []] 3D/ Alll

* v
|5y Copy Ctrl+C

I—/ Paste Ctrl+V
] @

e all select Al Ctrl+A
U | ® Find & Select.. Ctrl+F

5388 search & Replace Text...

BEC

Grouping 4

Display Order 4

Locking

Move T Unlock
U

Align oY Unlock All
Distribute

Reshape

* v v ¥ w

Element Settings

SromeL e )

Reference Line and Plane 4

f
[

3 Mesh

¢ The locked status of elements generated by the Grasshopper code is similar to the “preview”
status in Rhino. Parameters of locked elements can be modified only through the Grasshopper
code. After the elements are unlocked, their parameters can be modified in ARCHICAD.

e By default, a generated AC element’s parameters which are not controlled by the GH code will
have the same settings as the Default Settings of the corresponding tool in ARCHICAD at the
time the element was generated.

e Certain parameters of generated AC elements (those which are used in the node of the
generating component or their Settings nodes) can be edited in Grasshopper, as well as in
ARCHICAD after the elements are unlocked. However, the Grasshopper-based parameter control
takes priority over that in ARCHICAD as long as the GH-AC Connection is active. If a parameter of
an AC component in Grasshopper is assigned a value (e.g. you add a Number Slider), then that
value will be applied every time the Grasshopper code is executed. If you previously assigned a
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custom value to that element parameter in ARCHICAD, then that custom value, too, will be
overridden when the Grasshopper code is executed.

If you modify the parameter of a generated element in ARCHICAD using the element’s Settings
dialog box, and if that parameter is not controlled in Grasshopper (either because the parameter
is not available in the generating component or because the parameter has no assigned value in
GH), then your modification remains in effect, even if the Grasshopper code is executed.

If the GH-AC Connection is not active, then the GH code has no effect on the ARCHICAD project.
You can then freely modify even those elements originally generated by Grasshopper code.
However, once you reactivate the GH-AC Connection, the GH code again takes precedence in
terms of controlling the parameters.

If you use copy-paste to replicate elements in ARCHICAD which were generated from GH code,
then the duplicates will lose their connection to the Grasshopper code. Use this method to
create and compare various designs by trying different values for the Grasshopper parameters.

Suspended Connection: As long as a dialog box is open in ARCHICAD, awaiting user input, the
connection between Grasshopper and ARCHICAD is suspended. Even if the user changes an
input value in Grasshopper, the change will not take effect until the dialog box in ARCHICAD is
closed. Feedback on the suspended connection is shown in ARCHICAD’s Grasshopper Palette:
the green connection icon stops spinning. In Grasshopper, the nodes with pending input in
ARCHICAD's direction will turn yellow. A message also pops up to inform the user of which
dialog must be closed before the Grasshopper ARCHICAD Connection is resumed.

File Handling

Elements generated by the Grasshopper code are fully functional, native ARCHICAD elements
that remain in the project even if the GH code is not available. Thus, an ARCHICAD project that
includes elements generated from GH code requires no additional management. It can be saved
as usual to any of the available formats. You can reopen the project without any problem even if
the original Grasshopper code is not available (the elements generated from GH code will be still
be present in the project).

In contrast to ARCHICAD, Grasshopper can have several projects (GH definitions) running
simultaneously in a single instance of the application. However, only one of these files can
communicate with ARCHICAD at a time. To define which of the running Grasshopper files should
be connected to ARCHICAD, use the “Connect Document to ARCHICAD” dialog box, available
from Grasshopper’s File menu.
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Grasshopper - Definition_2 - m] X
Fle | Edt View Display Soltion Hel Definition_2
[7]  Mew Document CiisN ansform  Display | ARCHICAD
Open Document 0 [ | o
EI eﬂ 5] & tf Connect Document to ARCHICAD - O X
Recent Files s o0 = A
0 6] Select the Grasshopper document which should communicate with ARCHICAD @
& save Document CisS
5] SaveDocumertAs  CirlsShiftsS D 20 - Satue; i Hame. fiath |I Connect I
() Definition_2 C:\Users\Ibarothy\Desktop\ATMENE
Rl Y e Definiion_1 C:\Users barothy\Desktop \ATMENETI\Defi o
Definition_3 C:\Users\lbarothy\Desktop\ATMENETI\Def
Connect Document to ARCHICAD. en— ersbarothy! Desktop '
Export Quick Image. . Ctl+Shift+Q
8l Export HiRes Image
Document Propstties
Create User Object.
< >
E Ribbon Layout »
=
&5 Show In Folder
& Special Folders b
Preferences.. Cir+Shift=P
Close Definition_2 W
@ Autosave complete (280 seconds ago) 0.9.0076

The path of the currently active document is shown in bold.
The green icon indicates which definition is currently connected to ARCHICAD.

e |f you connect an ARCHICAD PLN project to the Grasshopper file which contains the elements’
origin code, the two files recognize each other, and you can continue your parametric design.
For this reason, it is recommended to save these file pairs to a single folder, and to use related
file names.

e ltis currently not possible to use the ARCHICAD-Grasshopper Connection in a Teamwork setup
(that is, with ARCHICAD and Rhino installed on different computers). An ARCHICAD file that
contains elements generated from GH code can be shared as a Teamwork file, like any other
ARCHICAD project, if the GH-AC Connection is disabled.
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Accessing GDL Parameters of

ARCHICAD Library Parts

By default, Grasshopper cannot access the parameters of ARCHICAD Library Parts. However, you
can modify a Library Part’s GDL code to allow Grasshopper to access the object’s GDL parameters
(see steps below). This is recommended for users familiar with GDL programming.

Note: Geometric Description Language (GDL) is the programming language of ARCHICAD library
parts. These library parts, with file format GSM, can be loaded into your ARCHICAD project
through the Library Manager. When you open a new project with a default template, a standard

ARCHICAD Library is automatically loaded.

To modify an existing Library Part to enable Grasshopper to access its parameters:

1. Go to File > Libraries and Objects > Open Library Part.
2. Select the Library Part that you want to edit.
3. Click View or Open.

| Y

File | Edit View Design Document Options Teamwork Window Test Help

D New TR+ -~ @~ 6 -Em
E; Open »

[ CloseProject  Ctrl+Shift+W

x [ [armehair 01 21]

Save Ctrl+S

Cl Saveas.. Ctrl+Shift+S

@] Publish BIMx Hyper-model...

Interoperability 3 LY
External Content r Open Library Part from:
| Libraries and Objects »| T Library Manager...
Info » Manage BIMcloud / BIM Server Libraries... -
. [&] ARCHICAD Library 21 "
Plot Setu B Create Container.
= Up-: . E’ [BImg] Background Images 21
Plot... @ Extract a Container... £ Himg] HOR Images 21
Page Setup..  Ctrl+Shift+P 4 [ ARCHICAD Library 21.Icf
& print.. Ctrl+P New Object... + B3 opject Librany 21
= s 4 B 1. BAsiC LIBRARY 21
Bt cul-q |85 Open Object.. Ctrl+Shift+ 0
= 4 B 1.1 Fumishing 21
= || Save Selection as... »
E@ Em Appliances 21
Em Bathroom Accessories 21
@ 5 :
R Import Blocks from DXF/DWG B Beds 21
Er'l B cabinets and Shelves 21
S Em chairs 21
= Couches and Sofas 21 &
< < >
Docum
2
+—t
pren

4. The GDL Editor is opened in a new tab, where you can edit the object’s GDL code.

Open Library Part

[EE] ARCHICAD Library 21

=1

Armchair 01 Armchair 02
21.gsm 21.gsm

v
Uk

= @

by

/Ny

Armchair 03 Armchair 04
21.95m 21.gsm
-

Bar Stool 21.gsm  Bean Bag 21.gsm

5. Click on the Parameters button (at left) to open the object’s parameter list.

6. Click New (at top left) to add a new parameter to the list.
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7. Set up this new parameter as follows:
Display: activate the red cross pushbutton to make the variable invisible on the user interface.
Variable: type "ParamcontrolByGrasshopper"
Type: Boolean

Name: enter any name

Value: ON
[ W SurveyPoint - GRAPHISOFT ARCHIC
File Edit View Design Document Options Teamwork Window Test Help
10 | R - 8 v &R0T x| \ @S -
|
[S10. Ground Floar] P 1armehair 03 21] x [JEo/an
o New Delete Q |3
o Display Variable Type Mame Value
fm [EI::I B||[U][ParamcontrolByGrasshopper || @ ¥ Off L] =
=] H A = Dimension 1 580
H - B O Dimension 2 680
° B i rad =] Height 300
- B gs_detlevel_3D_m 28 3D Detail Level Detailed
Details : gs_seat_height =] Seat Height 350
Parameters | B gs_2D_representation = 2D Representation
Migration H = gs_detlevel_2D Abc 2D Detail Level Scale Sensitive
Components B = gs_detlevel_2D_m 28 2D Detail Level 0
Descriptors
Scripts B = gs_SymbolType_Mask 28 Symbaol Type Enable Mask 4083
Master D H = gs_cont_pen U Contour Pen 4
2D /= = = gs_fill_type %, Fill Type 65
3D D H = gs_fill_pen U Fill Pen 19
Properties / - = gs_back_pen U Fill Background Pen 18
Parameter ] gs_min_space = Minimal Space
Interface = B = MSFront ey Minimal Space in Front 30
Enrar et | B = MSSide ey Minimal Space on Sides 150
Backward Migration ||[—] B = MSRear E_E Minimal Space Behind 300
H gs_3D_representation = 3D Representation
2D Symbol = B = gs_resol 28 Resolution 18
Preview Picture [ = gs_shadow = Shadow On
2D View ] B = gs_full_edit = Extra Hotspot Editing on
3D View D H )( AC_show2DHotspotsin3D = Show 20 Hotspots in 30 Off O
B )( ac_bottomlevel ey Bottom Level 1000
B )( ac_toplevel ey Top Level o
: gs_material = Surfaces
- = ne frama mat & Erama 12

8. After the new parameter is set, use File > Save as to save the Library Part under a new name to
the Embedded Library.

The newly modified, duplicate element is now available in Grasshopper.
9. In Grasshopper, place an Object Settings component on the canvas.
10. From the context menu, choose Select ARCHICAD Library Part.

11. From the appearing dialog, browse for the new element. Since Grasshopper detects the
ParamcontrolByGrasshopper parameter, the object’s GDL parameters are selectable on the
right. Every parameter that you check here will (after you click Select in the dialog box) appear
as an input parameter on the left side of the Object Settings component. From this point on,
you can define these GDL parameters, too, in Grasshopper.
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Select ARCHICAD Library Part Ba
Search Object | search Parameter:
Embedded Library Name Type  Variable Name
Linked Librares
{@) BlMcloud / BIM Server Libraries General
£ Buitn Libraries [ Dimension 1 = A

[] Dimension 2 =2

»
Enabled
& Bake..
I Select ARCHICAD Library Part I—} m
@ Hep. Test Object gsm

/b, Waming: Seting multiple Library Pan parameter i inconsistendies i
ARCHICAD element. For more information. open the Grasshopper- ARCHICAD Live Connection User Guide from ARCHICAD's Help menu.

[ Cancel |[ et

Note: Be careful when managing GDL objects via Grasshopper. Library part parameters are
often interdependent, and modifying one value will modify other values too. Grasshopper does
not detect this interdependence. If you adjust several values in Grasshopper which are
interdependent, an error may occur, if both Grasshopper and the GDL Parameter script seek to
modify the interdependent values simultaneously.

If contradictory information is given as parameter inputs for Library Elements in Grasshopper,
then objects may be placed differently than expected. The most common phenomenon that is
that Objects are not updated when a parameter is changed in Grasshopper. In case of Doors/
Windows, the settings dialog can misbehave when you try to edit the elements manually.

Grasshopper- unnamed 70 % Untited- GRAPHISOFT ARCHICAD 6420
Fe ER Vew Duly Sokton Heb seomed Pt View Design Document Options Teammork Window Help

QA D O- 8 - x| be N R2G -
FoI0 i) >0 L

Qx?ﬁ@ﬂ%%@:ﬂoltm”
160 0TS B|&
L owo ] Oocument ]

(= B-®-uw 200 ®0 0 U

[0, Greuns Fooy Ceosan @001 pezpectne) x Csoutn estion]

Synchronize

¢ synchronize
( Curve Wall ¥
¢ Wall Settings

( Horizontal Distance &

1
2
H
'E Window D
d Window serings [

Window Settings |}

inconsistent parameter setup (B oo

Q& e% |4 e s[@ v 2 [S conng | B Enemoseis | Y omenean

Recommendation: Do not use Grasshopper to modify multiple GDL parameters simultaneously
if their values are interdependent.
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